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New User Register

Step 1
Go to http://isms.com.my/register.php

Step 2
Insert

User Name

| password
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Log in

Step 1
Go to http://isms.com.my/index.php

Log in by
Name

WELCOME TO iSMS

Best Malzysia bulk SWE soltion, 2 way SME marketing.

+503- 79801388 (KL) +604-8420621 (PG) +6531584888 (S'pore)
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ISMS Main Member Page

_—

s[m[s| Call our hotline today! 1200-28-73223 2.0
@J ] Workrg Hear: Morday-Friday E:30aum . - 10000 m. & Login Name Credils Remaining @‘ = TOF P

Account Info
- SMS Balance
e by SR SNEMENCRN. il | RO < - Credits Expiry

2041216
il [ty » ExTEND

&% Logout

kv more people easlly. we wolld be glad ko arswer Al your
Compose and serd SHS kxlmessages queres .
s oy dle vormal. I allow you ko

L oI oK W KX I MET Fage Dat E

SMS Credit Reload — Profit Sharing : SMS Subscription Form .
e e ﬂ Sub-Keyword = $ L e el P
direcly Irbs SIS address book. —
] e T S VAT ; "

iSMS AP tahile Ads S5 Maonthly Report ~ nm
Frosdde ame hod ofinkaralng websllkes Kchlle 25 15 an mplemenkalon ot Wouable kodew your sms kancaclon |II JA';I
& pomiware wl I Our miessagirg planim . Kcbille Wb sdverizmenl. Vol can maniy Summary Wi h usirg s Raere. =k
creal Plohne + unllmlled Texl
adverlzemenl, ben serd o pour wers 1
—

Frougha link In S0, You can rack
Mewers loo.

Sub Account Report

WAL N 0 V& W TLUD-SCCOUNE TnE
I sz lon de s wihusirg s
ke

SMS Prefix Report

oAl ablE K MEW YO ST ranEaclon
pretx summany Wi using his eakee.

SME Monthly Summary .-ih-.l

o able ko iEw sms moniy summay 1
reparl wl i all your sub accoun|.

Multi Users Task Scheduler Birthday Remindar

“foul can row dew sub-acoounl smi Uslrg W #akre, you can schedule . Elrelays ard arnlversaies really ARE
ransacion de lals wihusirg Hs ZMZ ko be renl o angbady al any Tk 0 Imporian!! Sy Imiomed ot al upcoming




Click the SMS
menu, select

Histary ez s (i) » EXTEND Compose SMS

LR

5|m[s| Call our hotline today! 1300-38-7389 i » TOP UP
\iarkhg Hor: Mowda=F riday 8:30am . - 1000pm. Credte Remalilig
Prermium Ke

CompeSMS | C5 Compose || Matile Brochure I TE

arnplate

you can receive reply via Sms or email..
** ¥our phone number is not displayed and strictly confider
** Charge 1 sms credit per reply
*% Reply via E-mail is FREE Mahile Repott

duler




Compose SMS

Compose SH5 L5V Compose Mohile Brochune

1: Receive reply via SMS.

2: Receive reply via Email.

wou can receive reply via sms or email..,

=* Your phone number is not displayed and strictly confidential.
** Charge 1 sms credit per reply

** Reply via E-mbil is FREE

Ratslve raply vla sms: Example: G0LE1234567

Reacalva raply via ¢ma|2 e ryetion comn|
Example: supportd moebisweb. oo m.omy

Templats: 3 -ekotTemplak - (%

Maisage Type: t® Normal B English, B Melayu, te ) Unileodds [ Bg. Chine gs, Japans s, 8te)

Sand To: i Tinpartant:
Plepse use

|_| Ehone Book 4 semicolon
;or, to
seperate
each
phane

| number,
Please append "00" in front of international numbers in order Lo send
international SM5.

Long Messages Lo on 5
Slgnature {adit)  Test & signaturs to messags 6
Message : Hewt

Parsonall 2sd
i 159 characters lsft ) SME
? Pul
Wi ey
Lo be
replaced
with
name in
address
book.

Please da mol oopy & paste fram MS Words file, it may contain invalid charmcters,
SME will not delivered if invalid characters detected
Important! Please do ot refresh the page should and ermor everoccurs! If you are wondering

whether your messages have been sent, please close your biowser and log back in from the home
page, and check your history.

8 % Send MNow % Send Later 9

Ato Response’s

: = on on
Meriags '1 O
A

3:Template: Select Template to send SMS.

4: Send To: Enter your destination number to send, each
number need to use semicolon to separate, example :
60195002166;60164502380

5: Long Message:

- If you wish to send long message.

(more than 153 characters, you need to select long
message)

6: Signature:
- add on signature behind your message, example:-
Hi how are you << Company Name

7: Message Type:

- key in your message here and system will auto
calculate the characters left for you.

- for Normal message type, maximum 153 characters per
SMS credits, for Unicode message type, maximum 63
characters per SMS credits.

lick Send Now to send SMS.

Send Later for task scheduler.

esponse's Message
after receive SMS from customer.




CSV Compose SMS

AT Click the SMS
n menu, select
Compose SMS

2014-12-16
1216 iy exreny

@ﬂﬁ_ﬁ[i‘: Call our hotline today! 1300-88-7389
Wiorkiig Honr: ModayFriay830am. - 1000,

Compose M5 | SMS Reply Histary

SMS Ternplate

WOU Can receive reply via sms oNsmail.. Ta:
** Your phone number is not displayed and'S
** Charge 1 sms credit per reply

** Reply via E-mail is FREE abile Ads Repaort

heduler

"



CSV Compose SMS

Recaive rply via sms;

C3Y comnpose iz where you send SMS to a list of users via upleading
£V file

You can receive reply via sms or email.

** vour phone number is not displaved and stricly confidential,

** Charge 1 sms credit per reply

** Raply via E-mail is FREE

Exarnple: 80161234567

Receive raphivia email:2-f @y ahioocom

Template:

Message Type:

Upload C5W File :

Cuplicate Ho. Ched:

Signature (edit)

hessage

4 Chaose File | Mo Fle chaosen

Example: support@mobiveb, com.my

- Select Template - (¥ 3

t ® Hormal (Eg. English, B. Melayy, etc) Unicode (Eq. Chinese, Japanese, etd)

CEY Sample or Download 5V Sample

Pleaie ypkda ceu i Wi a proper fimat.
Headers cannot be modfied, no other values other than the anes litted ars accepted,

[%tphanenat, %nameds, Samaunt, Saddresd, Hatring1%, Hatring2 ¥, Hatring3®, Sstringdd, Stringsd)

‘5
o -Tesk Add signature to message 6

New! Perzonalized SMS
7 Put

Y%narne¥, Yarmount®

to be replaced with

narme and amaunt in
yaur csv file,

b

Please do not copy & paste from MS Words file, it may contain invalid characters,
SMS will not delivered if invalid characters detected

Important! Please do not refresh the page should and error ever occurs! If you are wondering whether
your messages have been sent, please close your browser and log back in from the home page, and check
your history.

example: "Hi, %name®%, your balance iz %amount¥".

Rezult : "Hi John, your balanee is 300"

8 » Send Mow | | » Send Later 9

1: Receive reply via SMS.

2: Receive reply via Email.

3:Template: Select Template to send SMS.

4: Upload CSV File : Select and Upload CSV files to send.

5; Duplicate No. Check:: Option to remove duplicate
phone number in CSV Files.

6: Signature:
- add on signature behind your message, example:-
Hi how are you << Company Name

7: Message Type:

- key in your message here and system will auto
calculate the characters left for you.

- for Normal message type, maximum 153 characters per
redits, for Unicode message type, maximum 63
ers per SMS credits.

d Now to send SMS.

ater for task scheduler.
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- How to Compose CSV File

CEY compose is where you send SMS to a list of users via uploading
CEVY file

You can receive reply via smz or email..

*## vour phone number is not displayed and strictly confidential,

*¥* Charge 1 =rns credit per reply

*##* Raply wia E-rnail is FREE

Receive reply via sms: ] Exarmnple: 60161234567
Feceive rephy via email: [+ @yahoo.com

Example: support@rnobiweb. corm.my

Template: | - Select Template - %

heszage Type: i '™ Marmal (Eg. English, B. Melayu, etc) ' Unicode (Eg. Chinese, Japanese gtc

Upload C5W File :
C5W Sample or Download C5W Sample

Choosa File | Mo file chosen

Plaie npkad aciy Mk Wil aproper mat.
Headers cannot be modified, no ather values other than the ones listed are accepted.
[¥phoneno®, Fnames, amount®, %address e, Tstringl3, %string2 36, %skring2%E, Hoskringd, HstringSe]

Click the CSV
Sample or
Download CSV
Sample and

download the
CSV file




How to Compose CSV File

To compose CSV SMS you must follow the format below:

Example:
Hi %name%, your credit balance is %amount%, please make payment to %string1%

Final Result:
Hi JOHN, your credit balance is 300, please make payment to test

TRRER" I A N - R A RAERAE RS T O Rl
4l - # Yphoneno%

s e T e e T s

Yphoneno Yname¥h  Y%amount% %address¥ Ystringl% YstringP% Y%string3% Y%strinsd% YstrinshHY%
BO1Z234567 89 TOHN 300 FJ,EL testl test? tests testd testh
60124456789 STEVEN 2 testh test? testh testd testll]

L=

|
DCI‘—-CI
|

P
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|Cﬁ Lo | '-blm
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How to Create CSV File in Excel

Please follow the format accordingly.

The mobile no (intended customer recipient) must begin with prefix 60.

i e
T ————

' Home Insert Page Layout Formulas Data Review View Acrobat

|@] | @ General 2 ij _}F

|
B
&
g
4
=
- 4
>,
PI-'l
I
I
I

Paste ¢ (B £ B -||E || O- A |E = = EE| B |8 % 0|48 Condtional Fo
Clipboard T | Font [= Alignment [w Mumber ] style
c3 - fe |
A | o s o | e | ¢ [ & [ .H | 1
\_%phanenc}% Saname% %amount% %address¥ Yastringl®% Yestring2% Ystring3% %stringd% %ostring5%
171234567 A
171234567 B .I
171234567 C

1
2
2
4 |
5 |
6
7
8
9




How to Create CSV File in Excel

How to change the phone no to prefix 60:-

Highlight all the phone no which copied from Service
Reminder database

Right click the selected phone no, and click format cells

— Home Insert Page Layout Formulas Drata Review WView Acrobat
= . = i s : —
Calibri bl R R || T (== gilﬁbvl = General - E E |
B = =3 |
Paste (B 5 T -8~ A E=E = =|2E2E|| B~ ||| % ~ % =* ||%8 ;28| | Conditional For
- F - = Formatting ~ as Tz
Clipboard = Font L} Alignment ] Number ] Style:
A2 - fe | 171234567
A Calibri -11 ~-|A" A" $ -~ % » J)_E F ] H I
1 |%6phonend g 5 = i3~ 3 - A - =8 50 B string1% %ostring2% Shstring3% Yostringa% Shstrings%
2 1?12345ur|;-\
3 1712345 x| cut
. | 1712345 -
= E3 | Copy
= i, | Paste
Paste 5 ial...
- aste Specia
a Insert...
q Delete...
10 Clear Contents
11 Filter >
1z Sort »
13
Insert Comment
14 -'? —
15 = Format Cells...
16 Pick From Drop-down List...
17 MName a Range...
18 ?_9 Hyperlink...
19

-—



How to Create CSV File in Excel

» Select Custom then key in “ GO###HHH####HE "(# 10 times).
« This will change all phone number to 60 formats

A B LE o} E F G H 1 1
1 |[%phoneno% %name% %%amount® %address% %stringl% %string2% %string3% %stringd% %string5%
2 1712345674
3 171234567]8 Format Cells TS L
4 1712345 6?.(2 2 — i
= Mumber | Alignment Font Border i Fill Protection
6 Category:
7 General - Sample
g Mienhe: 60171234567
Currency
9 Accounting I .
Date
10 e GOEZEHEEREL I
11 Percentage General -
O Fraction 0 |
Scientific 0.00 El
13 Text ¥ E
Special .00
4 EE— iz, ze0) I
15 )i [Red](=,#%0)
16 .00 _);(=,=x0.00)
.00_);[Red]{#,#%0.00)
17 §# #80_);(§%,£#0)
18 5%, ##0_);[Red] (5%, #%0)
o Type the number format code, using one of the existing codes as a starting point.
21
22
23
24
25 oK ] I Cancel |
26
4 E N

1 %phoneno% %name% %amount% %address% %estringl% %estring2% %estring3% %stringd® %astring5%
60171234567]A
B60171234567|B
501?123455?.C

(9= D B R = R =R TR R N




How to Create CSV File in Excel

Save as .csv format
@m MR — 2 T 0

W WView Acrobat
News Save a copy of the document |  E—
= A =) Wrap Text Custom
{5 & Excel Workbook HI/‘ - | = R
e [EiHl | Save the file as an Excel Workbook. J|‘E§ -§§| @MErgeB{Center* | § = 9%
. Excel Macro-Enabled Workbook 2 Alig.nme.nt - N"'_mbi
S [E Save the workbook in the XML-based and
F macra-enabled file format,
[f;l Excel Binary Workbook -_F _G _H _I
save s b | | Save the workbook in a binary file format ring2% %string3% S%stringd% %strings%

optimized for fast loading and saving.

Print » @ : Excel 97-2003 Workbook
[EHl | Save a copy of the workbook that is fully

compatible with Excel 97-2003.
Prepare » =
e Adobe PDF

Send L = OpenDocument Spreadsheet
Ji3d | Save the workbook in the Open Document

e Ndb 2T W

Farmat,
Publish » |
[=lx PDF or XPS
=5 Publish a copy of the workbook as a PDF or
XP5 file,
Close

-

2] Excel Options | | X Exit Excel | |




How to Create CSV File in Excel

Save as .csv format

Documents library

Includes:

[ Microsoft Office Excel
2 locations

- Favorites s
- Date modified

B Desktop
& Downloads

Mame

1/16/2012 12:37 PM

, Bluetooth Exchange Felder 11/28/2011 10:24 ...

. Dropbox

Arrange by:  Folder =

Type Size

File folder

File folder

Excel Workbook (*.xlsx)
Excel Macro-Enabled Workbook (*adsm)
Excel Binary Workbook (*.xlsh)

=
;= Recent Places

= Libraries Excel 97-2003 Workbook (*.ls)
3 T XML Data (*.xml)
Single File Web Page (*.mht;*. mhtml)
J“.' Music Web Page (*.htrm;*.html)
T : Excel Template (*xlt)
B Fictus Excel Macro-Enabled Temnplate (*.xltm)
B videos Excel 97-2003 Template (*xlt)

Text (Tab delimited]) (*.bd)
Unicode Teaxt (*.tut)
XML Spreadsheet 2003 (*acml)

1M Computer
‘?’ Local Disk (1
pace

—a Local Disk (D JTEKt (Macmtosh] (*.todt)
Text (MS-DOS) (*.bdd)
C5V (Macintosh) (*.csv)

CSV (M5-DOS) (*.csv)

DIF (Data Interchange Format) (%.dif)
SYLK (Symbuolic Link) (*.slk)

Excel Add-In (*xlam)

Excel 97-2003 Add-In (*xla)

PDF (*.pdf)

XPS Document (F.xps)
OpenDocurment Spreadsheet (*.ods)

‘E‘ﬂ Metwork

File name:

Save as type: [Elccel- Workbook (*.xdsq)

Authors: TY WONG Tags: Add atag

[ Save Thumkbnail

= Hide Folders

Title: Add a title

Tools ~ [ Save ] [ Cancel ]

T 090



How to Export Microsoft Excel
(2008) to CSV Iin Mac OS

1. Open / Create your Excel spreadsheet, select File > Save As... from your
Menu Bar:

ﬂ Excel lﬁﬂ Edit View Insert |

& MO Project Gallery... {r38P
Y1 3 Bl New Workbook 3N |
New Open Save  Open... %0

Open Recent e
A |
1 |First Name Close BW
2 | John Save 85 |
3 Jane
4 Bob Save as Web Page... :
g Ujaq Save Workspace...

Web Page Preview




How to Export Microsoft Excel
(2008) to CSV Iin Mac OS

2. A new window will appear and select Format from the drop down menu. Then
select Comma Separated Values (.csv) from the list as shown below.

(v

Save As: Workbook1.x/sx

Where: | (] Documents

Forma v Excel Workbook (.xlsx)

Description

The default, XML-based we
Cannat store VEA or Excel |

Excel 97-2004 Workbook (.xls)

Excel Template (.xItx)

Learn more about file form Excel 97-2004 Temlate [‘Hlt}
Comma Separated Values (.csv)

W Append file extensia  Web Page (.htm)

PDF

fr. Options... \‘ ’r Compi

Excel Binary Workbook {.xlsh)
Excel Macro-Enabled Workbook (.xlsm)
| Excel Macro-Enabled Template (.xltm)

Sawve As: Workbookl

| [ - | |Q Documents =
| FAVORITES 2013-00012 (1).pdf
o = 2013-00012.pdf
wiw Applications L
’ﬂg 2073_0001.pdf
[=] Desktop 3] 120313_V..._Asset_Pack ~
_ Downloads 167778_4...412_n.jpeg
@ Elacie i 395430 _1...860_n.jpeg
) About Downloads
E Movies Active Subscribtion only
Music e i SRR
- Excel Workbook (.xlsx)

Pictures
SHARED

2 dominic-mac...

Forma
Description

Exports the data on the act

Learn more about file form;

| Options... .I !. Compi

™ Hide extension [N

Excel 97-2004 Workbook (.xIs)

Excel Template (.xltx)

Excel 97-2004 Template (.xIt)
¥ Comma Separated Values (.csv)

Web Page (.htm)

PDE

aes in cells.

Excel Binary Workbook {.xIsb)

Excel Macro-Enabled Workbook (.xlsm)
Excel Macro-Enabled Template {.xltm)
Excel 2004 XML Spreadsheet {.xml)

Excel Add-In (.xlam) tended
Excel 97-2004 Add-In {.xla) I T
Single File Web Page {.mht) necel | | Save |

UTF-16 Unicode Text (.txt)
Tab Delimited Text (.txt)
Windows Formatted Text {.txt)
MS-DOS Formatted Text (.txt)

Windows Comma Separated (.csv)
MS-DOS Comma Separated (.csv)
Space Delimited Text {.prn)

Data Interchange Format (.dif)
Symbolic Link (.slk)

Excel 5.0/95 Workbook {.xIs)




How to Export Microsoft Excel
(2008) to CSV Iin Mac OS

3. When "Save As", you may choose to rename or pick another location to store
your file. Click "Save" at the bottom right of your screen.

Save As: | Workbook1.csv E1
Where: | 5] Desktop =)
Format: Comma Separated Values (.csv) v 1

Description

Exports the data on the active sheet to a text file that uses commas to separate values in cells,

Learn more about file formats

f_ﬂ Append file extension

\

¢ Options... ) 'f Compatibility Report... Compatibility check recommended

( Ccancel ) € Save-)




How to Create CSV File In

OpenOffice

1. Open .csv with OpenOffice Calc.
2. Select “Separated by Comma”.

l{j

File Edit Wiew Insert Format Tools Data ‘window Help

. i |Find
Arial 1 =
AL v| kB = |
e e e O
2 |
3 Text Import - [CS¥SampleDown csv]
4
* | Impork
:
T Character set Wwestern Europe (windows- 1252 fwinLatin 1) b
|
7 Language Default - English (USA) w
g
- -
10 Separatar options
11 () Fixed width

—— () Separated by

13
14 [J1ab | Comma |

[] other

15 [] =emicolon: || space
| 16 | [ Merge delimiters Text delimiter " £

17

13 Other options

19 [[] Quoted field as kext
| 20 | [ Detect special numbers

21

72 Figlds

23 Column bype

24

25 |Standard |standard |Standard  |Standard  [Standard  |Standard  [Star A
26 | | kphonenco:  3name: 3amcunts 3address: istringl: 3string?: st
— 2 B0léxxxinnx John =0 EL cestl besti bes
| 27 | 3 BO0l7xxxxxnx Steven Z PG Lestl bestE es

28 4 B019xxxxxxx Kelwvin 1 Singapore testl LestE Les

29

30 3

31 < >

32

38
| 34 |

35

36

37

Sheet1 [ Sheetz [ Sheetd <




How to Create CSV File In
OpenOffice

3. Highlight all the data in the table and select Format Cell.

1 |%phoneno%  %name% Yamount®  Yeaddress%  %estringl% Yestring2% Yostring3% %estringd %% Yostringd%
< B0164843799 John 30 kKL testl test? test3 testd tests
SN B01E4543799 Steven 2PG testl tests test3 testd tests
SN B01E4843799 Kelvin Defaulk Farmatting ke testl tests test3 testd gsts
5
&8
| 7| Insert., ..

g
g | Delete...

10 3  Delete Conkents...

11

17 =| Insert Comment

13
14 o cut

15 By Copy

16

17 [ij Paste

15 Paste Special...
B Selection List, ..

20 - -




How to Create CSV File In
OpenOffice

4. Select “Category > Number” & “Format > General”

Yphoneno% %narme%

Yoamount¥  Yoaddress% Yostringl% %stringd% [Sostring3® Yestringd%  Yostringd%
B0161234567 John 30/ kL test] test’ testd testd testh
- = testh
gsth
2— Numbers |F|:|nt Fonk Effects | Alignment | Borders | Background | Cell Prokection
E Cakeqory Farmat Language
8 ~ |DeFauIt -English {USa) % |
a F=— 4 ==
EtS Currency :1223;412
— Dake !
11| Time 1,234.12
12 | Scientific | |l2iz
13 Frackion
Ere Boolean Yalue v tests
15 Options
16 ) .
17| Decimal places [ ] Megative numbers red
_1& | Leading zeros 1 3 [ ] Thousands separator
19
? Eaormat code
T | zeneral |
22
[ 25 |
2t
| 25 | Ik l [ Cancel ] [ Help ] [ Resek
26

b
.
.



How to Create CSV File In
OpenOffice

5. After complete formating the files. At the top menu, select File > Save as

6. Select Save As Type > Text CSV(.csv)
Save As @@

Savein: | (B Desktop v O s M-
\ L5y Documents!
. 3 _é My Carmputer

My Recent ‘JM}-’ Mebwork Places
Documents [Z] csvsampleDownload

Desktop

_

ky Documents

oL

kA Camputer

‘\_-!] File name: C5WSamplel ownload b Save
by Metwark Save as pe: Text C5Y [ cav) v

Autamatic file name extension

[ 1Edit filter settings




How to Create CSV File In
OpenOffice

/. Select keep Current format when save.

OpenOffice 4.0.1 X

e

This document may conkain Formatking of conkent thak cannot be saved in
the Text CSY file format, Do wou want ko save the document in khis Format

Ay’

Use the lakest QODF file Format and be sure all Formatting and content is
saved correctly,

| Xeep Current Farmat: ||| Save in ODF Format

Ask when not saving in OOF Format




How to Create CSV File In
OpenOffice

8. Select Fields delimiter ( , ) and text delimiter ( “)
9. Select OK to save the CSV file.

Export Text File E|
Field options
ok
Character set Western Europe (Windows-1252 "WinLatin 1)
Cancel
Field delirniter . W Gl |
Text delimiter " v Help |

Save cell content as shown

[ Fixed column width

.



SMS Template

Click the SMS
menu, select
SMS Template

s[m[s| Call our hotline today! 1300-88-7389 il ;
Wiorking Hour: Monday-Friday 5:3530a.m. - 10000pm. Cre

Premium K

.|_i Add Template
emplate

Mame:
scheduler

Mezsage Type: & mormal (Eg. English, B. | nese, Japanese, etc)

Mezzane:



_
U] Ada Template 1: Name: Enter your Template Name
AIME 1
e 2: Message Type:
Mezzage Type: 2 & Narmal (Eg. English, B. Melayu, etc) ) Unicode (Eg. Chinese, Japaness, eic) - DefaUIt is Normal
Messsge: 3 - Select unicode, if you want to send Chinese,Japanese
(T or other special characters
TE0 characters left)
p 3: Message:
- key in your message here & system will auto calculate
Approval Status: YES = Allow to add template withaut spprovl the characters left for you.
MO = Allow to add template but need to wait for approval .
- for Normal message type, maximum 153 characters per
EXXTnL! sms crec or Unicode message type, maximum 63
c credits.

w template for approval

s



Generate SMS Report

T T I TN B WA W WA T

Call our hotline today! 1300-88-7389  [EEMEESELE

Wiorking Hour: Monday-Friday 8:30a.m. - 10:00p.m.

Login iISMS Member
Name panel and go to the

Premium Keyword top menu
=i Histary
S Select SMS > SMS
History
=S Reply Histary
“rom |2013-12-17 | [40 To [2013-12-17 Bl SMS Template
Zompose SMS Task Scheduler all
Phone llo ST Route Mobile Ads Report sentv
22013 wewewy izmz comumy . Al Fights reserved. Privacy Palicy | User Agreement

\.




- I
% e

From |2013-12-01 | ol To [2013-12-17 't} [Submit] [Export to Excel
Compose SMS Records 1 - 2 of Total 2 2 Gioto Page | Pres | Mext

Phone How Sent To Route SMS Sentw Sent By Date 3

6016 1) Malavsia 1.0 2013-12-16 10:14 AM Remove | Miew | Expart

a016 (1} Malaysia 1.0 2013-12-16 10:11 AM  Remove | Yiew | Export
201 3wy izms camumy. All rights reserved. Privacy Policy | User Agreement Software developed by Mobieb sdn bhd

1: To search sms history from date to d ms history to Excel.

2: Credi
- Show |

Send Detail: - ‘
its you us this tran: t you sent.

3:T0\; ary a




SMS Delivery Details Report

Sent

* Your message has been submitted to the Carrier's SMSC (Short Message
Service Center) and is waiting for the delivery status confirmation from the
Carrier

 The message may be delivered to your destination mobile number but
Carrier SMSC fail to return delivery status info.
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SMS Delivery Details Report

Delivered:
-Your message has been delivered to the destination mobile number

Delivered




SMS Delivery Details Report

Undelivered:

* Your message validity period has expired. This happens when the destination mobile
is either switched off or out of coverage area for a certain period of time. The SMSC
failed to deliver even after its final attempt as per its retry scheme

* Your message was not delivered. This happens when the Carrier encounters inactive
or unidentified or untraceable destination mobile number mobile handset memory or
inbox full.

o -5
i Ih. A '
T
@
v | ISMS “B
Gateway WView
Report
. dy,
, @
¢ ;
2 —"ﬁ View
: ﬁ;ﬁd} Report
. sy
IJ-_ b @
*
Al o
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SMS Delivery Details Report

Pending:
-Our server has accepted your message & is in queue to be
submitted to the Carrier (Network Operator)

Pending

o
)

Recipent




SMS Delivery Details Report

Fail

* Your message was rejected at the SMSC of the Carrier. This happens when
the destination network is not available or blocked to the Carrier.

 The failed SMS will not be charged.




SMS Summary Report

-

From [2013-12-01 | 66l To [2013-12-17 | 6] (Gubmit] [Export to Excel]
Compoze SMS Fecordz 1 - 2 of Taotal 2 Goto Page | Presy | Mext
Phone How Sent To Route SMS Sent~ Sent By Date +
016 1§ )] Malaysia 1.0 2013-12-16 10:14 AM  Remove | view | Export
G016 (1 Malawsia 1.0 20135-12-16 10:11 AM  Remove | view | Export
Phone No: Description:
6016 1 Success - Message senk.
Group ID:

S46303-0607 330001357 159597

Total Delivered: 0 (Export)
(Messages have been delivere& mobile operators SM3C with a successful delivery skatus - Your message has been delivered ta the destination mobile number)

Total Sent: | (Export)
(-¥our message has been #Mbmitted ko the Carrier”s SMSC (Short Message Service Cenker) and is waiting For the delivery skakus confirmation From the Carrier
-The message may be deliv8red to your destination mobile number but Carrier SMSC Fail to return delivery status infa, )

Total Undelivered: 0 (Export)

(Messages have been delivered b bile operator's SMSC with a Failed delivery status

-f'our message walidity period has expired. This happens when the destination mobile is either switched off or out of coverage area For a certain period af time.
The 3MSC failed to deliver even after its final atternpt as per its retry scheme

-f'our message was not delivered, This happens when the Carrier encounters

- inackive or unidentified or unkracesble destination mobile number

- mobile handset memory or inbo Full)

Total Pending: 0 (Export)
(Messages are currently bei rocessed - Our server has accepted vour message & is in queue ta be submitted to the Carrier (Metwark Operator))

Total Fail: 0
{our message was rejgfted at the SMSC of the Carrier. This happens when the destination netwark is not available or blocked ko the Carrier)

Zompare and Fesend

Message:
testing SMS




< SMS Scheduler

L. -

Campose 545 || 5V Compose || mlmﬂm|

yOu can receive reply via sms or email..

*% Your phone number is not displayed and strictly confidential.
** Charge 1 sms credit per reply

** Reply via E-mail is FREE

Recalvarsplyviamy: [ | g Exaimple: 60161234567

Ratelva reply via small: o | |

Exarmple: supporl@mobiweb.com,my

Tamplats: l-SeiectTempE'e- v
Herags Tipe: {0 Hormal {Eg. Engllah, B Malaju, st} (0 Unleods (B, Chingss, Japans s, st}
sand To:

oo |1

P

Total phone(s): 0

Mote: Due Lo inpul errors by users, phone count shown

here is only an estimated value,

Please append "00" in front of international numbers in order to send
international SMS.

Leng Messages T@oft O
slgnaturs (salt) Tt (1 dald Wignaturs to massage
Metiage

{ 153 characters laft | 2

B

Please do ot copy & paste from MS itmay
SMS will not delivered if invalid characters detected

Tmpottant:
Please use
semicolon
jor, te
seperate
each
phone
number,

Hew
Personall d
SMs

Put

Yo aimEYe
to be
replaced
with
natne in
address
book.

r 1! Please do not refiesh the page should and sirar ever 1 1F you are wonder
whether your messages have been sent, please dose your browser and log back in from the home

page, and check your history.

% Send Now % Send Later 3

1: Send To
- Enter your destination number to send.

- Separate each mobile number using semicolon.
e.g 60195002166;60164502380




SMS Scheduler (One Time/Daily)

Recipients) :

Message Type

Message Body

Tas Hame :

Description

Trigger Setting :

Start From :

016 1

£ MWormal (Eg. Englizh, B. Melayy, ete) 2

test 23 3
2013-12-18 4
One Time L 6
2013-12-18 ﬂ
7 » Creste Trigger » Cancal

P

Unicode (Eg. Chinese, Japanese, atc)

Enable :

at | -Hour- ¥ |

s

-Mins- ¥ | pm W

b4

1: Recipient number to send

2: Message Type - Default is Normal. If
you want to send Chinese, Japanese
or other special characters, you need
to select Unicode.

3: Message Body — message to send
4: Task Name — Enter your task name

5: Description — Enter your task remark

6: Setting — You able to send your start
date, start time and timer.

7: Click “Create Trigger” to add new
scheduler




Address Boo

= Address Book
s[m[s| Call our hotline todaylks oo
Wioding Hour: bdonday-Friday &
L=l LEraup
1ot Contar

— Add Contact

1. At the iISMS member
page, click the "Address
Book" menu tab and select
"Address Book".

Address baok | Add new contact

2. Click Add New Contact

Group| Al el Expc-rt phones|

1 Fhore Hurmber =

Rermowe Selected| AddiMaove selected t

L ET -




Address Book — Add Contact

| Address book || Add new contact

E Add Record
Group:
Name: S 1: Contact Information
Mobile Number: eq:G0123456739 Group
Emai 1 2: Birthday Remind and Birthday
Company Name: Message — auto send Birthday Message to
D.OE: —virr- wl[-mm- wl[-oo- v customer
Description:
3: Birthday Message Type - Default is
Normal, if you want to send Chinese,
v e oy o on ][ 9] 9 ’ Japanese or other special characters,
Send him £ her a bithday message on | a| gy you need to select uniCOde)

Birthday Greeting :

4: Group — Customer Group

Meszage Type : ® Hommal (Eq. English, B. Melayu, ete)
Unizode (Eq. Chinese, Japanese, ate) 3
Active: YES W

» Add




Address Book — Manage Group

At the iSMS member page,
click the “Address Book”
menu tab. Select "Manage
Group".
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- Address Book — Manage Group

;‘:‘I Add Group & Bewesord

Group: 1 Crour group name.)

Feymord: (Keyword for group broadeast, everyone in a group will received the message.)

(4w ] 9

Moveywou can send sms to wour group anytime, anywhere with your mobile phone, kindby follow steps below:

step 1: Add your Group and Keywword

step 2: go to Address Book to add your contacts (r'ou must be inthe same group to send this ShiS)

Eeynote: As owner of this account, your mobile no, rust also be inthe group to use the keyword

step 3: send <YW HEYWORD MESSAGE= to 26828 with yvour mobile phone, replace MESSAGE with any text {english only).

Forrat:
sand <hY HEYWIORD MESSAGE= to 2E222 with yvour mobile phone, wou can replace MESSAGE with any text (english anly).

Allyour group members will receive ywour sms almost immediately.

Mote:

1: you must make sure have enough credit to send.
2 only support ENGLISH message in this moment.
3 maximum 160 characters par mes=sage.

Eeynote: As owner of this account, wour mobile no, must also be in the group to use the keyword
<2 A
Group Heyneord Sample Total Group Member ) =«
Sroup A zend "MY¥ TEST MESSAGE' lo 36828 ] Edit | FRermowve | Rernowe with contacts
aroup B zend "™M¥ TEST MESSAGE" lo 36828 0 Edit | Remowve | Rerowe with contacts
Sroup C send "M¥ TEST MESSAGE" lo 36828 ] Edit | Femowe | Femaowe with contacts

1: Group Info!

2: Click to "Ac

3: Edit | Rem
(**Only the grc

4: Remove wi
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Address Book — Import Contact

lmmm C m_
s|m[s] Call our hotline todayatbiciiizbll 3.0
@_L]_‘ Working Hour: Mnnday—FridayBy ; : i » TOP UP

Login Mame Creditz Remaining
Manage Group

Import Contacts 1 ZDE'I}:J i-lzD-:tE % »w EXTEND

|t

i_| Import address book with CEY [zlick HERE for manual i mport ]

Upload C5V File : 2 Choose File | Mo file chasen 3 CSW Sample

Plase wpload a cru Tl whh a propes rmat

(name, phowe 1o, cescription, emall, compary, dobd™rr=RIM=-0 0, rem e Dirtkcky, o o
fonky vame and phowe ko, are mancaiony, othe rz can ke kthlaek)

Selectgoup: /]
5 | = Submit

1: At the iSMS n
2: Choose Files
3: CSV Sample -

4: Select Gro



Address Book — Import Contact

IPERED - - &8 = e @
—-j Home Insert Page Layout Formulas Crata Review WView Acrobat
e i — ' I EEES ]
= 4 Cut Calibri 11 A AT == =" Wrap Text General = E{i .5*1335 I—
. S oy =12 1 <3 =
Paste - || - || - - = = === 2= | E - ~ 8 || =2 .00 Conditional Format
= 7 Format Painter B I U (| 2~ A E = =||£E #£|| [=g Merge & Center | % Yo ¥ ||TEe & Edvatting = a5 Tabie > |I
Clipboard ] Font ] Alignment (= Mumber ]
A4 - £ |
A E C D E F G H | 1 K L
Mame A 60loxxxxxxx description email company 1983-01-14 N 14000 1Z2pm 1 hi happy birthday ¥
Mame B 6019xxxxxxx description email company 1983-01-14 N 14000 12pm 1 hi happy birthday ¥
company 1983-01-14 N 14000 1Z2pm 1 hi happy birthday ¥

1
2
3 |[Name C 6017xxxxxxx description email
a4
5

Parameters in CSV File

Column A* Name of your client, please enter phone nu

Column B* Phone Number

Column C Description

Column D Email Address

Column E  Company Name

Column F  Date of Birth _
Column G Enable Birthday Reminder to a
Column H Group, you must enter group n
Column |  Time to send birthday greetir
ColumnJ Message Type = 1

Column K Greeting message ( onl
Column L Enable Birthday Greetin

int owner, Y =Y
ame as your gr.
le: 12am or 1

Malay in
S,N=

as name if you do not have records




Convert E+11 to Number in Excel

Home Insert FPage Layout Formulas Data Review View Add-Ins

i

== ¥ Cut

Calibri =11 - |;!f ;:| |§ = §| ‘@WrapText General

~— 53 Copy : S :
F'ajte F Format Painter B I U - 8- ﬂ’}ﬁ_' A~ |E = =||iE i£|| =dMerge & Center - | | § T %

Clipboard ] Font l= Alignment ] Mumber

Al - fe | 601123456789
A B C D E F G H I |

1 ﬁ.ﬂ1123E+11.
2
b )

2. When Text Import
3. Your CSV file will k



f

Convert E+11 to Number in Excel

bgpd9-¢ )¢

A Home
| Home | Insert Page Layout Formulas Data

4. To remove the E+11, right click on the cell.
5. Select “Format Cell”

=

]

L Cut T [=
% Cu Calibri - -|A W||[= =
th 53 Copy T
aste =|[=EE = = A= =!=
- J Format Painter |B 410 ”— ” L ||==_
Clipboard ] Font l=
Calibri =~ 11 = A" A7 % ~ % “;55?89
B 7 = i-&-A %% E
1 £ 01123E+111
v %  Cut
3 53 Copy
4 I]g Paste
5 Paste Special...
6 Insert...
N Delete...
8
Clear Contents
9
10 Filter b |
11 Sgl't |
12 J Insert Comment
13 I|§ Format Cells... (t
14 Pick From Drop-down List...
— MName a Range...
16
Hyperlink...
17 % :
18
19
20

T



onvert E+11 to Number in Excel

ARG
e Home Insert Page Layout Formulas Data Review View Add-ns 6 SeleCt the hlghllghted format

- - a 13 ”
& Cut Calilori (11 AR = §| ‘@WrapText General 7 CIICk OK Y ]
o Gacopy = T [ | i Meroe & conter - | [BT a0 8. Finally, save the file.
- - Format Painter T ||| = EEE erge & Center . ,
Clipboard ] Font ] Alignment (] Mumber
Al - fe | 601123456789
A B fad r = E e H 1 1
» IEN
1 6.01123E+11 Format Cells ‘
2
3 Mumber | Alignment Font Border Fill Protection
4 Category:
5 General Sample
5 Currency 601123456789
Accounting ; . =
7 Date Decimal places: | 1] -
8 Time [] Use 1000 Separator {,)
g Percentage
Fraction Megative numbers:
10 Scientfic e ||
11 Text 1735
Special {1234)
12 Custom {1234)
13
14
15
16
17
12 Mumber is used for general display of numbers. Currency and Accounting offer specialized formatting
19 for monetary value,
20
21
= care
23




Thank You
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